Microsoft Access: Short Questions and Answers with Illustrations – Part 1

Published by
MCQ Sets
Kalanki, Kathmandu
Nepal

www.mcqSets.com

Copyright ©2014 author.

No part of this publication may be reproduced, stored in a retrieval system or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, scanning or otherwise except for personal and non-commercial use without the prior written permission of the author.
<table>
<thead>
<tr>
<th></th>
<th>Question</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>What is Database Management System (DBMS)?</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>What do you mean by data processing?</td>
<td>1</td>
</tr>
<tr>
<td>3</td>
<td>List some database applications.</td>
<td>1</td>
</tr>
<tr>
<td>4</td>
<td>What is MS-Access?</td>
<td>1</td>
</tr>
<tr>
<td>5</td>
<td>What is Database?</td>
<td>1</td>
</tr>
<tr>
<td>6</td>
<td>What is the extension of Access database file?</td>
<td>1</td>
</tr>
<tr>
<td>7</td>
<td>What is relational database?</td>
<td>2</td>
</tr>
<tr>
<td>8</td>
<td>What is a key field?</td>
<td>2</td>
</tr>
<tr>
<td>9</td>
<td>What is primary key?</td>
<td>2</td>
</tr>
<tr>
<td>10</td>
<td>What do you mean by foreign key?</td>
<td>2</td>
</tr>
<tr>
<td>11</td>
<td>What are the elements of a database?</td>
<td>2</td>
</tr>
<tr>
<td>12</td>
<td>What is a table?</td>
<td>2</td>
</tr>
<tr>
<td>13</td>
<td>What is a field?</td>
<td>3</td>
</tr>
<tr>
<td>14</td>
<td>What is a record?</td>
<td>3</td>
</tr>
<tr>
<td>15</td>
<td>What is a query?</td>
<td>3</td>
</tr>
<tr>
<td>16</td>
<td>What is a form?</td>
<td>4</td>
</tr>
<tr>
<td>17</td>
<td>What is a report?</td>
<td>4</td>
</tr>
<tr>
<td>18</td>
<td>What are the differences between a form and a report?</td>
<td>4</td>
</tr>
<tr>
<td>19</td>
<td>What is a macro?</td>
<td>4</td>
</tr>
<tr>
<td>20</td>
<td>What is a module?</td>
<td>4</td>
</tr>
<tr>
<td>21</td>
<td>What are the different Number field types in Access?</td>
<td>5</td>
</tr>
<tr>
<td>22</td>
<td>What do you mean by data processing?</td>
<td>5</td>
</tr>
<tr>
<td>23</td>
<td>What are the ten field types in Access?</td>
<td>5</td>
</tr>
<tr>
<td>24</td>
<td>What are the two types of data processing techniques?</td>
<td>6</td>
</tr>
<tr>
<td>25</td>
<td>What is batch processing or offline processing?</td>
<td>6</td>
</tr>
<tr>
<td>26</td>
<td>What is online processing or real-time processing?</td>
<td>6</td>
</tr>
<tr>
<td>27</td>
<td>Who introduced Relational Database Model?</td>
<td>6</td>
</tr>
<tr>
<td>28</td>
<td>What are the front-end and back-end components of a database?</td>
<td>6</td>
</tr>
<tr>
<td>29</td>
<td>What are link tables?</td>
<td>6</td>
</tr>
<tr>
<td>30</td>
<td>What are the objects of Access Database?</td>
<td>7</td>
</tr>
<tr>
<td>31</td>
<td>What is the meaning of following field properties? Field Size, Format, Input Mask, Caption, Decimal Places, Default Value, Validation Rule, Validation Text, Required, Allow Zero Length, Indexed.</td>
<td>7</td>
</tr>
<tr>
<td>32</td>
<td>What is datasheet view?</td>
<td>8</td>
</tr>
<tr>
<td>Question</td>
<td>Page</td>
<td></td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>33. What is a sub-form?</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>34. What do you mean by filter?</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>35. What is Lookup Field?</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>36. What are the three key components of relational database design?</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>37. Define entity:</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>38. What are attributes?</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>39. Define relationship.</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>40. How many relationships are possible between two tables or entities?</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>41. What is cardinality?</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>42. What do you understand by one-to-one relationship between two tables?</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>43. Clarify one-to-many relationship between two tables.</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>44. Define many-to-many relationship.</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>45. What is identifying relationship?</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>46. What are the advantages of normalizing database design?</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>47. What are the E.F. Codd's normal forms?</td>
<td>11</td>
<td></td>
</tr>
<tr>
<td>48. How is &quot;no nulls&quot; constraint implemented for an attribute?</td>
<td>11</td>
<td></td>
</tr>
<tr>
<td>49. How is a &quot;no changes&quot; constraint implemented for an attribute?</td>
<td>11</td>
<td></td>
</tr>
<tr>
<td>50. How is a &quot;no duplicates&quot; constraint implemented for an attribute?</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>51. What are the different ways to add a table in Access database?</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>52. What do you mean by default value for a field in Access table?</td>
<td>13</td>
<td></td>
</tr>
<tr>
<td>53. What is 'Required' property of a field?</td>
<td>13</td>
<td></td>
</tr>
<tr>
<td>54. What do the following formatting symbols mean in Format properties of fields? &lt;, &gt;, @&quot;NULL&quot;, @&quot;Not entered&quot;, $</td>
<td>14</td>
<td></td>
</tr>
<tr>
<td>55. What is the use of Validation Rule property of a field?</td>
<td>14</td>
<td></td>
</tr>
<tr>
<td>56. What is 'Input Mask' field property?</td>
<td>14</td>
<td></td>
</tr>
<tr>
<td>57. What is the use of Validation Text property of a field?</td>
<td>14</td>
<td></td>
</tr>
<tr>
<td>58. How can you import a table created in another database or other file formats?</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>59. How can you view the entire data of memo field?</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>60. What is the easiest way to define a relationship between two tables?</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>61. What do you understand by Referential Integrity in Relationships?</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>62. What is the effect of enabling 'Cascade Delete Related Fields' when defining relationship?</td>
<td>16</td>
<td></td>
</tr>
<tr>
<td>63. What is the effect of enabling 'Cascade Update Related Fields' when defining relationship?</td>
<td>16</td>
<td></td>
</tr>
<tr>
<td>64. What is a switchboard?</td>
<td>16</td>
<td></td>
</tr>
<tr>
<td>65. What is an AutoForm?</td>
<td>16</td>
<td></td>
</tr>
<tr>
<td>66. What are the three different forms of auto forms?</td>
<td>17</td>
<td></td>
</tr>
</tbody>
</table>
67. Each object on the form has its own property sheet. What are the different ways to evoke property sheet?

68. What is the form view?

69. What are controls? How to use them? Give examples for control.

70. What is the use of the form design window?

71. What are the ways to create a new form?

72. How can you show only selected records with a form?

73. What is Dynaset?

74. What are the different useful tools available in Design Window to help you with your design work?

75. What is a Field List tool available in Design Window?

76. What is the difference between using a filter and a query to find records?

77. What are the different options that you can use to filter records?

78. How can you apply Filter For option to filter records based on a value of a field?

79. Explain Query.

80. What is an Auto Report?

81. Explain Query Parameters.

82. For what an append query be used?

83. What is a crosstab query wizard?

84. What is the advantage of Report Wizard over an Auto Report?

85. Why Report Design View is important?

86. What is the use of Label Wizard?

87. What are the different auto reports available in Access?

88. What are the different sections of a report?

89. What are some of the database object operations that a user must know?

90. What is a macro?

91. What is the difference between Print Preview and Layout Preview?

92. What are command buttons? How to use command buttons?
Short Questions And Answers
What is Database Management System (DBMS)?

The computer software to manage, maintain database as well as view update and retrieve data is called database management system.

What do you mean by data processing?

The term data processing embraces the technique of sorting, relating, interpreting and computing items of data in order to provide meaningful and useful information.

List some database applications.

Some of the popular database management systems are: Oracle, Sybase, MS Access, MS SQL Server, Paradox, DB/2, Dbase, FoxPro, MySql

What is MS-Access?

MS-Access is a RDBMS (Relational Database Management System) application developed by Microsoft Inc. that runs on Windows operating System.

What is Database?

A database is an organization of data related to a particular subject or purpose so that the data can be retrieved or processed.

What is the extension of Access database file?

The extension of MS-Access data file is MDB.
What is relational database?
A database with tables related to each other on a common field to facilitate the data retrieval from multiple tables is known as relational database.

What is a key field?
A common field on which two tables are linked is known as key field.

What is primary key?
A primary key is a rule which ensures that unique data is entered for the field and the field is not left blank. This is the field that would identify a record uniquely in a table.

What do you mean by foreign key?
The common field in child table that maintains relation with master table is foreign key.

What are the elements of a database?
The major six elements of a database are

- Tables,
- Queries,
- Form,
- Reports,
- Macros,
- Modules

What is a table?
A table is a collection of data about a specific topic such as products, students or suppliers. A table organizes data into columns (fields) and rows (records or tuples).
What is a field?

A field in a database is a piece of information about a subject. Each field is arranged as a column in table.

What is a record?

A record is complete information about a subject. A record is a collection of fields and presented as a row in a table of database.

What is a query?

A query is a question about data in database. It results a set of data from database that can be used as a source of records for reports and forms.
What is a form?

Entering and viewing data directly on the database table is not always convenient. So, a form is created to facilitate easy entering data and created that retrieve records from a single table or from multiple tables.

What is a report?

A report is an object in MS-Access that is used to view and print data. Though a Report is similar to a form; its specialty lies in special features like help to summarize data.

What are the differences between a form and a report?

Forms are primarily used to edit overview data whereas reports are used primarily to print or view data.

In a form your usually navigate from one record to another, whereas in reports summarized data are possible to present.

What is a macro?

A macro is an object in MS-Access that is used to execute one or more database commands automatically. Macros are useful in tasks such as printing month-end reports, adding new record to a table, printing letters to customers periodically.

What is a module?

A module object in Access is a program written using VBA (Visual Basic for Application) to automate and customize database function.
What are the different Number field types in Access?

The different number field types are:

- Byte
- Integer
- Long Integer
- Single
- Double

What do you mean by data processing?

Data processing is the technique of sorting, relating, interpreting and computing items of data in order to provide useful and meaningful information.

What are the ten field types in Access?

The ten different field types in Access are:

- Text
- Memo
- Number
- Date/Time
- Currency
- Auto-Number
- Yes/No
- OLE Object
- Hyperlink
- Lookup Wizard
What are the two types of data processing techniques?

The two types of data processing techniques are batch processing or offline processing and online processing or real-time processing.

What is batch processing or offline processing?

Offline processing is a technique in which data is collected for a pre-determined period of time, after which it is processed. For example payroll processing, inventory processing. It is time delay data processing system.

What is online processing or real-time processing?

This is data processing technique where data is processed in real time. This is used when delay in handling data is undesirable. Examples of online data processing systems are air ticketing system, banking system etc.

Who introduced Relational Database Model?

Dr. E. F. Codd introduced relational database model.

What are the front-end and back-end components of a database?

The back-end database file contains the tables. Other database objects such as queries, forms, reports, macros, modules and the links to the tables in back end are known as back end database components.

What are link tables?

Links of the tables in other databases or files created in Access database so that the data can be viewed and edited in Microsoft Access in addition to the original software.
What are the objects of Access Database?

The objects of Access Database are: Tables, Forms, Reports, Queries, Macros and Modules

What is the meaning of following field properties?

Field Size, Format, Input Mask, Caption, Decimal Places, Default Value, Validation Rule, Validation Text, Required, Allow Zero Length, Indexed.

Field properties and their meaning are described below:

Field Size: Maximum number of character or value you can enter in field.

Format: Format for the field. It gives the layout for the field.

Input Mask: A way or pattern of data to be entered.

Caption: The label for the field.

Decimal Places: The number of digits to the right of decimal place.

Default Value: The value automatically entered for the new record.

Validation Rule: An expression that limit the value to be entered in the field.

Validation Text: The message to be displayed while user violates the rule when entering data.

Required: The data should be entered the field can't be left blank.

Allow Zero Length: Permits zero length of string.

Indexed: The field is to be indexed. Indexing speeds up the searching & sorting.
What is datasheet view?

Datasheet view is a window that displays data from a table or query in row and column format where you can edit fields, add, delete data as well as search for data.

What is a sub-form?

A subform is a form contained within another form or a report. This feature is useful to represent one-to-many relationship between tables. In the form we can show the data of the Master table and at the same time in a second form we can show related data from the transaction table.

What do you mean by filter?

Filter is the process of hiding all unnecessary records or displays only the records that satisfy the criteria specified.

What is Lookup Field?

A Field that stores a list from an existing table or query or a fixed set of values that is looked up.

What are the three key components of relational database design?

The three key components of relational database design are: entities, attributes and relationship.

Define entity:

An entity defines any person such as student, teacher; place such as classroom, building; thing such as computer, lab equipment; concept such as course, attendance for which data will be collected.
**What are attributes?**

Attributes are one of the building blocks of relational database design that define the additional characteristics or information for an entity.

For example, name, gender, address, salary, years tenured can be the attributes of teacher entity.

**Define relationship.**

A relationship is a logical linkage between two entities that describe how the entities are associated with each other.

**How many relationships are possible between two tables or entities?**

There are three relationships possible between two tables namely: one-to-one, one-to-many, many-to-many.

**What is cardinality?**

The most important classification of a relationship is called its cardinality. The cardinality of a relationship allows the database modeler to specify how instances of each entity relate to each other. The three major cardinalities are: one-to-one, one-to-many, many-to-many.

**What do you understand by one-to-one relationship between two tables?**

A relation between two tables such that one primary key value corresponds to one foreign key value is known as one-to-one relationship. In
other words, each record in parent table is related to one and only one record in child table is one-to-one relationship.

**Clarify one-to-many relationship between two tables.**

A relation between two tables such that one primary key value corresponds to many foreign key value is known as one-to-many relationship. In other words, each record in parent table is related to zero or many records in child table is one-to-many relationship.

**Define many-to-many relationship.**

A relationship where many instances of an entity are associated with many instances of another entity is known as many-to-many relationship. Consider the enrollment relationship between a student and a class tables. A single student may be enrolled in many classes and a single class may enroll many students.

**What is identifying relationship?**

If the primary column is contributed to the child table's primary key or in other words, the foreign key is one of the columns in the child table's primary key, then this relationship is called an identifying relationship.

**What are the advantages of normalizing database design?**

The advantages of normalizing database are:

- Dependencies between data are identified.
- Redundant data and all of the problems associated with it is minimized
- The data model is flexible and easier to maintain.

What are the E.F. Codd's normal forms?

Following are the Codd's normal forms:

- First Normal Form: Eliminate repeating groups of attributes in an entity.
- Second Normal Form: Eliminate partial key dependencies, i.e. each attribute in an entity must depend on the whole key, not just a part of it.
- Third Normal Form: Eliminate redundant information by eliminating interdependencies between non-key attributes.

How is "no nulls" constraint implemented for an attribute?

The not null (NN) concept allows the database designer to force the user to enter a value in a particular column. The not null concept is used for columns involved in a primary key. The option must be set when table is created, and set by using the NULL or NOT NULL keywords.

How is a "no changes" constraint implemented for an attribute?

The no change (NC) concept allows the database designer to prohibit changes to the values in a column. This concept is used mainly for columns participating in primary keys. Preventing changes to a primary key is recommended because primary

---

**http://mcqSets.com** Microsoft Access Short Questions and Answers
keys are used to create relationship between tables, and changes to a primary key could result in a referential integrity violation.

**How is a "no duplicates" constraint implemented for an attribute?**

The no duplicate (ND) concept specifies that the values in a column must be unique. This concept is used in primary keys and alternate keys.

**What are the different ways to add a table in Access database?**

Three are five different ways you can add a table in Access database. They are: Datasheet View, Design View, Table Wizard, Import Table, and Link Table.

**Datasheet View:** In datasheet view you can enter the field names and records as in Excel sheet. Access defines correct field types and sizes based upon the data you enter for the field. A table is added when you save the datasheet.

**Design View:** In design view you will specify the field name, data type and various required options for the field. A table is added when you save the design.

**Table Wizard:** Table wizard provides you sample tables and sample fields from which you can select the required fields. After completing the wizard a table is added in database.
Import Table: You can import tables defined in other access databases or other document types such as Excel Workbook, dBase database, Exchange file, HTML document, Lotus spreadsheet, text files and many more. A table is added to the database after import operation is complete.

Link Table: Tables in other access databases or other file formats can be linked to access database so that the data can be edited both on the Access and the original source application. A linked table is added after the link operation is complete.

What do you mean by default value for a field in Access table?

Default value specifies the value that must be displayed in a particular field when making the data entry. For example you can specify 'Nepal' for the Country field. When entering record the value 'Nepal' will appear automatically and can be modified if required.

What is 'Required' property of a field?

Required property specifies if data must be entered in a field or not. If set to Yes, user can’t leave the field blank.
What do the following formatting symbols mean in Format properties of fields?

- `<`, `>`: Display contents in lower case and upper case, respectively.
- `@"NULL"`: Displays NULL if left empty.
- `@"Not entered"`: Displays 'Not entered' if field is empty.
- `$`: Right aligns text in column.

What is the use of Validation Rule property of a field?

Validation rule property allows specifying what validation must be made for the data entered in the field. If anything is specified in the validation rule property, only the data that satisfies the condition specified can be entered, all other data is rejected.

What is 'Input Mask' field property?

Input mask specifies the format in which the data must be entered. For example, if phone number must be displayed as (977) 428-0628, enter the input mask property as !((999) 000-0000;;_).

What is the use of Validation Text property of a field?

When the data entered in a field does not confirm to the validation rule that is specified, an error message is displayed on the screen that informs the user what is wrong. Validation text is
used to display custom error message instead of default error message.

How can you import a table created in another database or other file formats?

Access provides facility to import tables from other database or other file formats such as excel workbook. To import a table Choose 'File > Get External Data > Import'. Alternatively, you can choose Import option on New Table dialog box.

How can you view the entire data of memo field?

In datasheet view you can directly enter text but if you wish to view entire data of memo field you need to open the zoom window. To open zoom window press Shift+F2.

What is the easiest way to define a relationship between two tables?

To define relationship between two tables, the easiest way is by dragging the primary key field of parent table and drop on the foreign key field of child table, then click 'Create'.

What do you understand by Referential Integrity in Relationships?

Referential Integrity is a rule says that table must not contain any unmatched foreign key values. For example there can't be a fees record for a student who is not enrolled.
**What is the effect of enabling 'Cascade Delete Related Fields' when defining relationship?**

If cascade delete related fields option is enabled, Access automatically deletes related records in the child tables if the record from master table is deleted. For example if a student is removed then all the records related to the student must be deleted from fees table, marks table and so on.

**What is the effect of enabling 'Cascade Update Related Fields' when defining relationship?**

If cascade update related fields option is enabled, Access automatically updates the key field value of related records in the child tables if the primary key field value from master table is updated. For example if a student roll number is changed then all the roll numbers of that student must be updated in fees table, marks table and so on.

**What is a switchboard?**

A switchboard is simply a form with command button that open other switchboard or perform tasks such as opening forms and printing reports. Switchboard is a tool in Access to create a database application. You can use Switchboard Manager to create switchboards.

**What is an AutoForm?**

AutoForm is a wizard in Access that creates the specified type of form from selected table or query. To create an AutoForm Select the Forms tab and click on New button.
What are the three different forms of auto forms?

The three different types of auto forms are:

- Columnar
- Tabular
- Datasheet

Each object on the form has its own property sheet. What are the different ways to evoke property sheet?

The different ways to evoke property sheet are:

- Right Click the object and select properties
- Select the object and click properties from forms design toolbar
- Double click the object

What is the form view?

Form View is the presentation of the fields of a table in a format suitable for data entry as various controls can be placed on the form.

What are controls? How to use them? Give examples for control.

Controls are objects that can be placed in a form. The different controls are available in the Tool Box. After selecting the control in the toolbox it can be placed on the forms. After placing the control we can set its properties to serve our request. Examples for controls are, textbox, label, List Box, Check Box, Option Buttons etc.
What is the use of the form design window?

The form design window is where the user can customize the window. Customizing is the process of modifying the form design to suit user requirements.

What are the ways to create a new form?

You can create a new form in any of the following three ways:

- Using AutoForm: You can create a form based on a single table or query quickly using Autoform.
- Using Form Wizard: You can create a form based on multiple tables or queries using Form Wizard.
- Design View: You can create a custom form on your own in Design View.

How can you show only selected records with a form?

There are different ways in which you can limit the records that you will see with a form, you can:

- Open a form and apply a Filter.
- Create a query that selects records and base the Form on that Query.

What is Dynaset?

A dynaset is a subset of the data stored in database that is displayed by the query.
What are the different useful tools available in Design Window to help you with your design work?

The different tools available in Design Window are:

- The Forms Design Toolbar
- The Formatting (Form/Report) Toolbar
- The Toolbox
- The Field List
- The Properties Sheet
- Various Control Wizards

What is a Field List tool available in Design Window?

The field list is a handy way to reference fields in the Design View Window. To show the field list, click on the field list button on the Design toolbar. You will see a list of fields from the table or query, which is the source of data for the form.

What is the difference between using a filter and a query to find records?

We can use a Filter to quickly limit the records we are already viewing in a Datasheet or a form to those that match the criteria that we specify. In contrast to this, we can use a Query to view selected fields and records from one or more tables, then save the query to open it later or use it as the basis of a form or a report.
What are the different options that you can use to filter records?

The various options available to filter records are:

- Filter by Form
- Filter by Selection
- Filter for Input
- Advanced Filter/Sort.

How can you apply Filter For option to filter records based on a value of a field?

To apply Filter For option to filter based on a value of a field:

- Right click on the field and type the criteria in Filter For text box of the context menu

Explain Query.

Queries are used to retrieve and display specific records in a table. They can also be used to display specific fields of specific records, which meet the condition specified. A query displays a subset of all or specific fields and records in a table. When a change is made to the data, which is displayed by the query, this change is reflected in the table also. Because of this dynamic relationship between the query and the tables, the subset of the data displayed by the query is called a Dynaset.
What is an Auto Report?

An auto Report is the quickest way to create a report for a table or query. It generates the report with the table name as the heading and page number as the footer.

Explain Query Parameters.

If the conditions of the query should be entered at the time of execution of query, we specify the query parameter instead of criteria value or constant. Query parameters are specified inside large braces. Thus, when the query is run, the values of parameters are asked and accordingly the records will be presented.

To set query parameter, type the message inside large brackets in the criteria box of required field. To specify data type of parameter you can select Parameter option from Query menu. In the parameter column, type the message entered in Criteria box then, selects the type of the value that the user has to enter when query is executed in the Data Type column from the drop down list.

For what an append query be used?

It is easy to append records from one table to another using an append query. There is no need for the tables to have the same number of fields or same field names. However, the two tables must have matching fields and the data for primary key field should be unique and non-empty.

What is a crosstab query wizard?

A wizard that helps us to present the data in a 2-dimensional tabular format is the crosstab query wizard. You can use this to create queries that will depict the data in particular fashion, i.e. item wise sales made or customer wise sales made etc.
What is the advantage of Report Wizard over an Auto Report?

It takes a little more work to create a report with the report wizard than with the Auto Report but you have a lot more control over what the final result looks like. This is an advantage of Report Wizard over an Auto Report.

Why Report Design View is important?

Report Design View is where reports can be designed from scratch. It is where you can give your personal touches to the Form or Report Design.

What is the use of Label Wizard?

The label wizard creates report designs that can be used to print custom or built-in labels.

What are the different auto reports available in Access?

The different auto reports available in Access are:

- Columnar AutoReport: creates a report where each row is presented vertically.
- Tabular AutoReport: creates a report where data is presented in table form.
- Label Report: creates a mailing list.
- Chart Report: creates a chart report.
- Design View: helps us to create a report based on user requirement.
What are the different sections of a report?

A report is divided into many sections:

- The Report header: In this section you place a control which must appear only at the beginning of the report.
- The Page header: In this section you place a control which should appear at the beginning of every page.
- The detail band: It is the heart of the report. Here you place controls that must appear once for every record.
- The Page footer: In this section you place a control, which must appear at the foot of every page.
- The report footer: In this section you place a control which must appear at the bottom of the report.

What are some of the database object operations that a user must know?

Some of the database objects operation that a user must know is How to delete objects, copy objects, and rename objects if necessary.

What is a macro?

A macro is a set of instructions, which can be executed repeatedly. It is useful for automating certain routine tasks like printing reports etc. The macro once created can be executed from buttons or any other controls.
What is the difference between Print Preview and Layout Preview?

A report may be seen in two ways: Print Preview and Layout Preview. When a report is viewed in Print preview, it appears almost exactly as it would as when printed. MS-Access does the entire necessary math for calculated and summary fields. In contrast if you view the report in layout view, Access does not do all the calculations. Hence this is a quick way to check your work as you design the report.

What are command buttons? How to use command buttons?

Command buttons are referred to as controls. The control is capable of executing a set of instruction when the user clicks on it. In order to create and use command buttons select View > Toolbox. In the Toolbox select the command button and place it on the form by clicking and dragging. The command button wizard is started which allows you to specify the event.